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Notices

Trademarks
AJA® and Because it matters.® are registered trademarks of AJA Video Systems, Inc. 
for use with most AJA products. AJA™ is a trademark of AJA Video Systems, Inc. for 
use with recorder, router, software and camera products. Because it matters.™ is a 
trademark of AJA Video Systems, Inc. for use with camera products.

CION®, Corvid Ultra®, lo®, Ki Pro®, KONA®, KUMO®, ROI® and T-Tap® are registered 
trademarks of AJA Video Systems, Inc. 

AJA Control Room™, KiStor™, Science of the Beautiful™, TruScale™, TruZoom™, 
V2Analog™ and V2Digital™ are trademarks of AJA Video Systems, Inc.

All other trademarks are the property of their respective owners.

Copyright
Copyright © 2019 AJA Video Systems, Inc. All rights reserved. All information in 
this manual is subject to change without notice. No part of the document may be 
reproduced or transmitted in any form, or by any means, electronic or mechanical, 
including photocopying or recording, without the express written permission of AJA 
Video Systems, Inc.

See "Colorfront Copyright Notices" on page 53 for more information.

Contacting AJA Support
When calling for support, have all information at hand prior to calling. To contact AJA 
for sales or support, use any of the following methods:

Telephone +1.530.271.3190

FAX +1.530.271.3140

Web https://www.aja.com

Support Email support@aja.com

Sales Email sales@aja.com

https://www.aja.com
mailto:support%40aja.com?subject=
mailto:sales%40aja.com?subject=
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Chapter 1 – Introduction

Overview
AJA's HDR Image Analyzer simplifies monitoring and analysis of 4K/UltraHD/2K/
HD, HDR and WCG content in production, post, quality control (QC) and 
mastering. Tools include waveform, histogram, and vectorscope displays and Nit-
level HDR monitoring.

Combining AJA’s production-proven and powerful video and audio I/O with HDR 
analysis tools from Colorfront in a compact 1RU chassis, the HDR Image Analyzer 
offers a flexible solution for monitoring and analyzing HDR formats including PQ 
(Perceptual Quantizer), Hybrid Log Gamma (HLG) and Rec.2020 for 4K/UltraHD 
workflows. Colorfront has exclusively licensed its Colorfront Analyzer software to 
AJA.

Software Features
•	 Precise, high quality UltraHD UI for native-resolution picture display
•	 Advanced out of gamut and out of brightness detection with error tolerance
•	 Support for SDR (Rec.709), ST2084/PQ and HLG analysis
•	 CIE graph, Vectorscope, Waveform
•	 Out of gamut false color mode to easily spot out of gamut/out of brightness 

pixels
•	 Data analyzer with pixel picker
•	 Up to 4K/UltraHD 60p over 4x 3G-SDI inputs
•	 SDI auto signal detection
•	 File base error logging with timecode
•	 Display and color processing look up table (LUT) support
•	 Line mode to focus on a single horizontal line as the region of interest
•	 Loop through output to broadcast monitors
•	 Still store
•	 Nit levels, audio levels, and phase metering
•	 Built-in support for color spaces (including camera colorspaces)

Hardware Features
•	 One RU height chassis
•	 Hot swappable redundant power supplies
•	 Four DisplayPort outputs
•	 Four USB 3.0 connectors
•	 Two Network Interface Cards
•	 Three year warranty
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Chapter 2 – HDR Image Analyzer Hardware

Overview
AJA's HDR Image Analyzer is a 1RU hardware appliance equipped with AJA input 
and output. The system is designed for immediate use, automatically powering 
up to the Colorfront Analyzer application.

Chassis Front
Figure 1.  HDR Image Analyzer Chassis Front View

Cooling Air�ow Entrance Power Switch

Chassis Power Button

The main power switch is used to apply or remove power from the power supply 
to the system. Turning off system power with this button removes the main 
power but keeps standby power supplied to the system. Therefore, you must 
unplug all system power cords before servicing. 

Chassis Rear
Figure 2.  HDR Image Analyzer Chassis Rear View

Cooling Air�ow Exit
Rear and Top Panels

USB 3.0 
Ports (4)

SDI Reference
1.0/2.3 DIN BNC 

Input (R)

SDI Output
1.0/2.3 DIN

BNCs (#5-#8)

SDI Input
1.0/2.3 DIN

BNCs (#1-#4)

DisplayPort
Connectors (4)

Unused

Unused

Reserved 
for IPMI

Active RJ-45
Ethernet (2)

Redundant
AC Power Supplies

Rear Panel Power Supply LEDs

On the rear of each power supply module an LED indicates its status as follows.
•	 Solid Green: When illuminated, indicates that the power supply is on.
•	 Solid Amber: When illuminated, indicates the power supply is plugged in and 

turned off, or the system is off but in an abnormal state.
•	 Blinking Amber: When blinking, this system power supply temperature has 

reached 63°C. The system will automatically power-down when the power 
supply temperature reaches 70°C and restarts when the power supply 
temperature goes below 60°C.
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Chapter 3 – System Installation

Installation Summary
1.	 Unpack the shipping box, removing the HDR Image Analyzer, two power 

cords, and nine BNC adapter cables. 

2.	 Mount the physical chassis as desired, using the provided sliding rails. 
Cooling airflow enters the chassis from the front, and exits from the rear and 
top panels. Do not obstruct these air vents.

3.	 Connect the two HDR Image Analyzer power cords to mains AC. For 
redundancy, use both power supplies and connect them to separate branch 
circuits so that the HDR Image Analyzer will continue to operate even if a 
circuit breaker opens on one branch.

4.	 Connect a computer monitor (user supplied) to one of the rear DisplayPort 
ports.

5.	 Connect a keyboard and mouse (user supplied) to available rear USB 3.0 
connectors.

6.	 Connect the 1.0/2.3 DIN to full-size BNC adapter cables to the 
HDR Image Analyzer inputs and output connectors.

7.	 Connect the HDR Image Analyzer inputs to your video source, and outputs 
to your mastering display monitor, if used.

8.	 Power up the chassis. The system will boot up to the Analyzer application.

Hardware Installation

Shipping Box Contents
An HDR Image Analyzer is shipped with two AC power cords. Rackmount brackets 
are provided as part of the chassis.

As you unpack the shipping box, carefully examine the contents. Ensure you 
received everything and that nothing was damaged during shipment. If you find 
any damage, immediately notify the shipping service and supply them with a 
Description of the damage. AJA will repair or replace damaged items.

If you find shipping damage, contact your AJA dealer or distributor for details on 
how to have your HDR Image Analyzer repaired or replaced.

NOTE:	 Save packing materials and the shipping box. If your HDR Image Analyzer ever 
requires service or you move your system, use the packaging materials and box 
for safe shipment.

Rack Mounting the Chassis
Install the HDR Image Analyzer chassis into a standard 19-inch wide equipment 
rack, allowing space for cooling airflow. The chassis occupies only one vertical 
rack unit.

Two rack rail assemblies are included in the rack mounting kit. Each assembly 
consists of two sections: an inner fixed chassis rail that secures directly to the 
server chassis and an outer fixed rack rail that secures directly to the rack itself.
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The rail assemblies are shipped with rack adapters installed for use with IT (square 
hole) style rack frames. For IT racks, simply slide the unit into place, as the rails will 
lock automatically. For use with a standard round hole rack frame, you will need 
to remove the adapters using a small Philips head screwdriver. 

Network Configuration
The HDR Image Analyzer ships configured for DHCP operation. If your facility 
uses DHCP, simply connect one of the active Ethernet RJ-45 connectors to your 
network.

To manually configure your HDR Image Analyzer's IP addresses, on the Analyzer 
application press the Tab key on the keyboard when no dropdown menu is visible 
to open the Settings screen, and select NETWORK.

See "NETWORK Tab" on page 33 for more information.

Initial System Startup
On initial system startup, no login is required, but you will need to accept EULA 
for Microsoft and NVidia. EULA is displayed on the first startup and after every 
update.

Software Update
AJA's HDR Image Analyzer ships with Colorfront's Analyzer software preinstalled 
with the latest version. 

Updates to the software are available at:

https://www.aja.com/products/support/hdr-image-analyzer

To update HDR Image Analyzer software:

1.	 Download the .zip file and extract and copy the .ajas file to a USB stick.

2.	 Insert the USB stick into a rear USB port on the HDR Image Analyzer chassis.

3.	 Go to Help > Update Analyzer.

4.	 Select the downloaded .ajas file and click Select File. 

5.	 The software will be installed, and when complete the message 
"Preparation Complete, please restart Analyzer" appears.

6.	 Click on the Analyzer > Application Restart menu item to complete the 
update.

Licensing
The HDR Image Analyzer comes with an internal license already activated. No 
user involvement is required for licensing.

NOTE:	 The Help > License Utility menu is for future use.  

https://www.aja.com/products/support/hdr-image-analyzer


HDR Image Analyzer ﻿ v1.0r3	 9	 www.aja.com

﻿

Chapter 4 – HDR Image Analyzer GUI

Overview
HDR Image Analyzer is a real time video analyzer for QC, Mastering, Grading 
and Broadcast. The simple, easy to use graphical user interface features unique 
options designed specifically for HDR work. When the HDR Image Analyzer 
hardware starts up, the GUI automatically launches.

Views
The Analyzer uses screen layouts with either a Quadrants view or Single view.

Figure 3.  Quadrants View Example (Default)

 

Figure 4.  Single View Example, Waveform RGB Color

 

Drop-Down Menu Navigation
A top menu bar appears when the cursor is moved to the top of the screen. These 
menus can be used to select layouts and configure settings. Clicking on a menu 
name opens that menu. 
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Pressing the ESC key also displays the Drop-Down menus.

Figure 5.  Selecting Colorspace Using Drop-down Menu

 

When a drop-down menu is displayed:
•	 The currently selected setting is indicated with a (+) in front of that menu item.
•	 The left and right arrow keys can be used to move to an adjacent menu, or 

open an additional parameter menu for the current menu selection.
•	 The up and down arrow keys moves the selection up or down that drop-down 

menu.
•	 Pressing the TAB key selects the next drop-down menu to the right. Shift TAB 

moves the drop-down menu selection to the left.

NOTE:	 When the menu bar is not displayed, the TAB key opens the Settings screen. See 
"Settings Screen" on page 32 for more information.

Selecting Views with the Keyboard
When a drop-down menu is not open, computer keyboard function keys can also 
be used to activate the layouts.

Table 1.  Analyzer Mode Shortcuts

Function Key Activated Layout

F1 Show Single View video image

F2 Show Single View Waveform

F3 Show Single View Gamut

F4 Show Single View Vectorscope

F5 Show Quadrants with Audio (either Phase or Level)

F6 Show Quadrants with Color Picker

F7 Show Quadrants with Vectorscope

F8 Show Quadrants with Log

F9 Show Quadrants with Info Page
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The following shortcuts, using the CTRL key, also affect the current view. 

Shortcut Waveform/Histogram Display

CTRL+F1 Select Luminance Waveform

CTRL+F2 Select Luminance Waveform with Colors

CTRL+F3 Select Color Waveform

CTRL+F4 Select RGB Color Waveform

CTRL+F5 Select RGB Waveform

CTRL+F6 YCbCr Waveform

CTRL+F7 Select YRGB Waveform

CTRL+F8 Select Histogram Luminance

CTRL+F9 Select Histogram Color

In addition, the following useful shortcuts are available:

Shortcut Color Space Setting

CTRL+F10 Sets Color Space to SDR Rec 709

CTRL+F11 Sets Color Space to HLG Rec 2020

CTRL+F12 Sets Color Space to HDR Rec 2020 

CTRL+space Toggles Single Line Mode ON and Off

Keystrokes for each shortcut are listed in the drop-down menus. See "Chapter 6 
Menu Reference" for a complete listing of all keyboard shortcuts.

Analyzer Modes
The waveform, histogram, and vectorscope are a form of oscilloscope and are 
used to monitor video brightness, contrast, hue, and color saturation.

•	 The waveform displays the luminosity or brightness and contrast of the pixels 
in the video frame, with the top of the y-axis indicating a high luminosity level, 
and the bottom indicating a low luminosity level.

NOTE:	 Waveform views can be magnified 4x using the Waveform Zoom control. Use the 
mouse to move up and down the display.

•	 The histogram shows the number of pixels in relation to a given list of 
luminance, or colors in a specific color space.

•	 The vectorscope displays values for hue and color saturation. The color 
saturation of each pixel in the video frame is shown, with the middle of the 
circle indicating a lower saturation level, and the edge of the circle indicating 
a higher saturation level. Hue is represented by placement in the 360 degree 
angle of the circle.

NOTE:	 The Vectorscope view can be displayed at either a 75% or 100% size (the 
percentage changes the graticules on the Vectorscope, not the rasterized image), 
and can be magnified with the Vectorscope Zoom control.

•	 The gamut screen shows a CIE xy gamut graph reporting the color values 
present in the image, with a graticule showing the limits for various standards 
(709, P3, 2020).

Several Analyzer view modes are available.
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Figure 6.  Waveform Luminance Mode

Waveform showing only luminance (Y) and no color information. Each pixel on 
the graph shows the frequency of the corresponding luminance value in the 
given column. Higher luminance value means lighter image content, lighter pixel 
means higher frequency of that luminance value.

Figure 7.  Waveform Lumi Color Mode

Waveform showing both luminance and color information. Here, in addition 
to the Waveform Luminance mode, the graph is colored according to color 
information. The hue and saturation of a pixel shows the sum of the dominant 
colors having the corresponding luminance value.
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Figure 8.  Waveform Color Mode

Waveform showing the RGB channels superposed in one graph.

Figure 9.  Waveform RGB Color Mode

Waveform showing the RGB channels in a split view, where each graph is shown 
in its respective color.
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Figure 10.  Waveform RGB Mode

Waveform showing the RGB channels in a split view, where each graph is shown 
in monochrome. 

Figure 11.  Waveform YCbCr Mode

Waveform showing luma (Y), blue minus luma (Cb), and red minus luma (Cr) in a 
split view.
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Figure 12.  Waveform YRGB Mode

Waveform showing luminance and RGB channels in a split view, where each color 
channel graph is shown in its respective color. 

Figure 13.  Histogram Luminance Mode

Histogram Luminance is showing the frequency of luminance values throughout 
the current image content. Left-hand part is for darker, right-hand part is for 
lighter image content.
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Figure 14.  Histogram Color YCbCr Mode

Histogram Color showing the frequency of RGB channel values throughout 
the current image content, superposed. For each channel, the left-hand part 
is represents image content for “0” or Black, while right-hand part represents 
image content for "1" and White. The 0-1 range is a scale, also represented as code 
values: (0 = 0,0,0 and 1 = 1023,1023,1023) in 10 bit code value for R, G & B.

Figure 15.  Vectorscope Mode with markers indicating 75% values
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Figure 16.  Vectorscope Mode with markers indicating 100% values

Vectorscope is showing the hue and saturation of all pixels throughout the 
current image content. The middle of the circle indicates a lower level of 
saturation, while the edge of the circle indicates a higher level of saturation. The 
brightness of the graph shows the frequency of the respective color in the image 
content.

NOTE:	 A skin tone line is also available on the Vectorscope graticule, adjustable using 
the Skin Tone X and Y controls in the Settings menu.

Figure 17.  Gamut Mode (CIE xy Graph)

This mode displays a CIE xy Gamut, showing various output referred color gamut 
standard limits, and also has Brightness and Gamut bars.



HDR Image Analyzer ﻿ v1.0r3	 18	 www.aja.com

﻿

Brightness and Gamut Bars

This view also contains two bars: the brightness bar on the left indicates the 
brightest pixel detected, the gamut bar on the right shows if the colors are within 
the legal color gamut. The maximum values are calculated using the Tolerance 
parameters available in the Settings Screen. The P3 color space is the limit. 

Framing Guides
HDR Image Analyzer supports two framing guides, Safe Title and Safe Action. 
Enabling "Safe Area on Image" displays the guides configured in the SAFEAREA 
sub-page of the Settings screen. You can display either the Safe Title, Safe Action, 
or both boundaries. The CTRL+s hotkey combination enables and disables the 
framing guide display. 

Figure 18.  Framing

Timecode on Image
The timecode is captured from several areas including the SDI and may be 
displayed on the image by selecting the Window › Timecode on Image menu 
option.
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Figure 19.  Timecode on Display Image

Lower Right Quadrant Displays
The lower right quadrant of the HDR Image Analyzer GUI can display audio 
information, a Pixel Picker, Log data, or Incoming Video Signal Info Page.

When in a quadrant mode, Gamut information is displayed in the upper right 
quadrant.

Audio Monitoring
The lower right quadrant of the HDR Image Analyzer GUI can display audio 
information.

Audio Phase Meter
Analyzer supports an audio phase meter which can be configured to display 
either two channel (stereo) or eight channel (surround) audio. When configured 
to display two channels, channels 1-2, 3-4, 5-6, or 7-8 may be displayed. When 
configured to display 8 channels, channels 1-8, or 9-16 may be displayed.
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Figure 20.  Audio Phase Meter

Audio Level Meter
Analyzer supports an audio level meter with up to 16 channels which can be used 
to monitor audio levels and also display peak DB levels.

Figure 21.  Audio Level Meter

Pixel Picker
The lower right quadrant of the HDR Image Analyzer GUI can display the Pixel 
Picker information. See "Pixel Picker" on page 29 for more information
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Figure 22.  Pixels Quadrant View

 

Log Data
Selecting "Combined with Log" displays the current log data. This information can 
be saved to log files. See "Logging" on page 32 for more in formation. 

Figure 23.  Log Data Quadrant View

Info Page
Selecting "Combined with Info Page" displays useful information about the 
current HDR Image Analyzer settings.
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Figure 24.  Info Page Quadrant View

Other Features
Other configuration options are available in the various HDR Image Analyzer 
menus. See "Chapter 6 Menu Reference" for additional information.
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Chapter 5 – Using HDR Image Analyzer

HDR Image Analyzer Setups
The top menu bar Setup menu is used to create, select, and save Setups of views 
and parameter settings.

Figure 25.  Setup Menu

Setups are always updated with the currently selected settings. If you want to 
retain the current settings of a Setup, after the Setup has the desired settings 
create or load a different Setup. Then any subsequent parameter changes made 
will be applied to that new Setup. When you open the original Setup in the future 
it will have all the desired settings.

Create Setup
Opens a window to name and create a setup of the current settings.

Open Setup
Displays a list of the current setups for selection. 

Delete Setup
When a Setup has been opened, you can delete it with this choice. The default 
“analyzer” setup then gets loaded.

Reset Setup
Resets the current Setup to factory default values.
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Video Menu
The top menu bar Video drop-down menu is used to define the characteristics of 
the video signal being analyzed, and can be used to capture and recall still video 
images for detailed analysis. 

Figure 26.  Video Menu

 

Resolution
Drop-down menus permit selecting HD, 2K, UltraHD, or 4K resolution and related 
settings to manually match the incoming video being analyzed.

Auto Detect Options
The Auto Detect Options setting is used to make the HDR Image Analyzer 
automatically select the number of incoming video signals to be used, depending 
on the detected video, or to force the use of only the first BNC input connector, or 
force the use of all four input connectors. The auto detection is based on the VPID 
video payload identifier (SMPTE 352M).

Auto Mode - HDR Image Analyzer automatically detects incoming video and uses 
either one link, or four links as appropriate. 

Forced 1x SDI Connection Mode - Forces use of only BNC input connector one.

Forced 4x SDI Connection Mode - Forces use of all four input BNC connectors.

Auto Detect
The incoming video is examined and matching settings are applied. The Auto 
Detect Options above can be used to force single or four link connection mode. 
The auto detection is based on the VPID video payload identifier (SMPTE 352M).

2SI LFR and HFR Input
For LFR (Low Frame Rate) 2SI video the Analyzer only uses SDI input 1 and 2 (four 
wire LFR 2SI is not supported at this time). 

For HFR (High Frame Rate) 2SI video all 4 SDI inputs are used.
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Capture
Captures the current video image. Up to four frames can be captured.

NOTE:	 Captured images are volatile, and will be lost when the  HDR Image Analyzer is 
turned off. 

Recall
Recalls the selected captured video image for display and detailed analysis. 

Screenshot
The Screenshot menu lets you capture the current Analyzer UI screen displayed on 
the connected computer, complete with all the current analysis values. Screenshots 
are saved as .png files to the local host computer, and can then be copied into a 
different folder (for example an attached USB flash drive). 

Save Screenshot
Captures the current Analyzer UI screen. You can also use the CTRL+e hotkey.

Copy Screenshots
Copy All Screenshots - Opens a file browser window allowing you to select the 

drive and folder into which all the currently captured screenshots will be copied.

Copy Today's Screenshots - Copies only the screenshots captured today.

Copy All Except Today's Screenshots - Copies all captured screenshots except 
those captured today.

Delete Screenshots
Delete All Screenshots - Deletes all currently captured screenshots. Does not affect 

screenshot files that have been copied into another folder.

Delete Today's Screenshots - Deletes only the screenshots captured today.

Delete All Except Today's Screenshots - Deletes all captured screenshots except 
those captured today.

Analyzer Color Space and Range
You can find the analyzer range configuration options in Analyzer > Analyzer 
Color Space menu.

The Analyzer supports Camera Log, and SDR and HDR (HLG and PQ) color space 
modes. Select the appropriate option from the Analyzer > Analyzer Color Space 
menu that matches the current image result.

Camera Log Analysis
Several original camera log curves are supported for processing media in the 
original capture color space. Supported formats are the following:

•	 ARRI LogC WideGamut
•	 CanonLog2
•	 CanonLog3
•	 Panasonic VLog/VGamut
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•	 Red WideGamut/Log3G10
•	 Sony SLog3/BT2020
•	 Sony SLog3/SGamut3
•	 Sony SLog3/SGamut3Cine
•	 ACEScct

In these modes, the waveform graticules are displayed in camera stops. To set 
up the base level and the warning level, adjust the following settings in the QC 
section of the Settings page (open with Tab):

CameraBaseGrey - Base grey level in nits; the 0 exposure line will be drawn at 
this level.

CameraWhiteStopsOverGrey - Brightness warning level; it stops over base 
level.

SDR Analysis
For working with SDR gamma encoded broadcast or cinema signal, set the 
Analyzer Range to SDR. Possible color primary options are the following:

•	 Rec.709
•	 P3 DCI
•	 P3 D65
•	 Rec.2020
•	 XYZ DCI

HLG Analysis
HLG mode supports the variable Hybrid Log-Gamma color encoding. In this 
mode, code values range from 0 to 1 and pixels do not have a specific nit level 
interpretation. Possible color primary options are the following:

•	 Rec.709
•	 Rec.2020 (with gamut warning for colors outside of P3)

HDR Analysis
HDR mode supports High Dynamic Range analysis. Peak brightness values above 
the maximum allowed nit level are indicated red on all graphs.

Possible color primary options are the following:
•	 Rec.709
•	 P3 D65

NOTE:	 By default, the peak brightness threshold is set to 1000 nits according to the 
HDR10 standard. When working with PQ masters of higher peak brightness, the 
corresponding maximum brightness needs to be adjusted on the QC section of 
the Settings page (open with Tab).

•	 Rec.2020 (with gamut warning for colors outside of P3)
•	 XYZ DCI
•	 XYZ D65
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CIE xy Gamut View
The CIE xy Gamut View can be used to check the encoded colors on a standard 
CIE xy graph, and to see if they are within the valid color range in case a specific 
gamut constrain is to be enforced. This is relevant when working in the Rec.2020 
color space, so the operator can identify that the colors are outside of the P3 
gamut. This is a requirement for several currently popular delivery formats.

Figure 27.  CIE xy Graph with Brightness and Gamut Bars

This view also contains two bars. The one on the left is the brightness bar that 
indicates the brightest pixel detected on the actual frame. The one on the right 
is the gamut bar that shows if the colors of the actual frame are within the legal 
color gamut (P3 in case of Rec.2020 input color space).

HDR Image Analyzer uses thresholds when detecting these extremes, so using 
the default settings a few pixels are allowed to exceed the legal limits without 
triggering a warning.

NOTE:	 Cumulative maximum values can be displayed on the Brightness and Gamut bars 
using the Log > Show Maximum Values parameter.

YCbCr Matrix
For the purpose of showing YCbCr components in various graphs (such as the 
vectorscope or the waveform YCbCr), the result image is converted to the YUV 
space. Select from the following formats for the specific matrix transformation:

•	 Rec.2020
•	 Rec.709
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Figure 28.  Signal Analysis with CIE xy Gamut Graph and Vectorscope

NOTE:	 The above settings will be reflected in the CIE xy graph and the gamut meter.

White Point Compensation
White point is a marker on the CIE graph. White point compensation D65 however 
is an option to change processing, so that if you are in XYZ Gamma2.6 colorspace 
(Digital Cinema) you can change the Vectorscope and Waveform processing so 
that the balanced white would be D65 instead of DCI. By default DCI white would 
be in the center of the Vectorscope, and DCI white would have the same level in 
the three channels of the waveform. If you turn on White Point Compensation to 
D65, then D65 white would be in the center of the Vectorscope and D65 white 
would have the same level in the three channels.

•	 The White Point Compensation parameter in the Analyzer menu turns 
compensation On and Off, which will change the analysis of the incoming 
video.

•	 The White Point parameter simply displays a box for either D65 or DCI on the 
CIE graph, and does NOT alter the analysis of the incoming video. 

False Color
It is possible to use QC Player for checking illegal or near-illegal brightness and 
gamut levels by enabling the False Color mode. The available False Color display 
modes are the following:

•	 Brightness
•	 Brightness Warning
•	 Gamut
•	 Gamut Warning

In the Warning modes, pixels that are too bright or out of gamut are colored 
red. Values at 90% of threshold are orange. The rest of the pixels are displayed in 
grayscale.
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Pixel Picker
The Pixel Picker is always active. With a left click of the mouse you can pick any 
pixel on the image (Full Screen or Lower Left Quadrant.) Pressing F6 activates the 
Lower Right mode, providing an extra precision view with per-pixel granularity.

Figure 29.  Pixel Picker

Pixel Picker Modes
From the menu the operator can choose how to inspect the pixel color values. 
The options are:

Hexadecimal mode - Displays the hex code values of the pixels.

Decimal mode - Displays the decimal code values of the pixels.

Nit value mode - Displays the pixel brightness in Nit level.

Single Line Mode
Single Line Mode limits the analysis to a single horizontal line of video. This mode 
can be used by a QC operator to verify blanking. 
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Figure 30.  Single Line Mode

The line being analyzed is indicated with a contrastingly colored line, and the 
number of the line is shown on the upper right.

Single Line Mode is turned on and off with the Analyzer Mode menu, or with the 
CTRL+space hotkeys. Additionally the hotkey CTRL + Up/Down Arrow moves the 
single line mode up and down one line at the time.

LUTs

Overview
Lookup Tables (LUTs) allow the mapping of colors between color spaces. 

The HDR Image Analyzer allows external Lookup Tables (LUTs) to be used for two 
different purposes:

•	 A Display LUT is only applied to the image being shown and does not affect 
the actual analysis of the pixel values. This can allow an operator to look at a 
correct image on a display device that does not match the current video signal 
type.

•	 A Scope LUT is applied to the video signal being processed, so all scopes, 
waveforms etc. will be based on the remapped image. 

No external LUTs are provided with the HDR Image Analyzer. Users can create and 
load custom LUTs, if desired, provided they are formatted as either a *.cube or 
*.3dmesh LUT file.

LUT files are loaded into and deleted using the Setup > Manage LUTs menu 
(Figure 31 on page 31), but are not active until selected for use as either an 
Analyzer Scope LUT or an Analyzer Display LUT (Figure 32 on page 31), using the 
Analyzer menu selections. 
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Figure 31.  Manage LUTs Menu

Figure 32.  Analyzer Display LUT Menu

 

Analyzer Scope LUT

Generally the No LUT Analyzer Scope LUT setting should be used to maintain the 
correct color analysis.

Display Scope LUT

Generally the Auto Analyzer Display setting should be used, which enables 
HDR Image Analyzer to use its internal, calibrated LUTs for proper display. 
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Logging
Analyzer detects the events below and logs them with time stamps in a log file 
and on screen:

•	 Gamut violations of the current colorspace.
•	 For HDR, P3 Gamut violation if HDR Colorspace is set to Rec2020.
•	 For HDR, Brightness violation. Max brightness for HDR is configured in the 

Settings > QC tab.
•	 Time Code break

Figure 33.  Logging with Show Maximum Values Selected.

A new log file can be created by starting a QC session from the Log drop-down 
menu:

•	 Start Log to File (CTRL+l)
•	 Clear Log Data (CTRL+d)

You can also select the timecode or session clock to be used in the log:
•	 Log Window Timecode 

Settings Screen
Advanced features are available on the Settings screen, allowing customization of 
the HDR Image Analyzer GUI for special purposes. The Settings screen is accessed 
by pressing the TAB key when the top menu line is not displayed. Click on the 
desired tab to display the available parameters.

QC Tab
These advanced settings are for experienced colorists and QC professionals, 
permitting customization of the values used for analysis.

The QC parameters are saved in Setups. If you Reset a Setup, all values in QC are 
returned to Defaults.
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Figure 34.  Setting Screen, QC Tab

 

The parameters are largely self explanatory, but the following special features are 
available.

Additional Marker for HDR
This control lets you add an additional custom level marker line to the Waveform 
view. As an example, if mastering for 600 Nits Rec2020, you may want to add a 
“600” line for visual reference.

•	 Range 1000.0 to 10,000.0 
•	 Enter -1 to hide the custom level marker line

Skin Tone
You can adjust the location of the skin tone line on the vectorscope display by 
entering X and Y CIE coordinates. The default location of the skin tone line varies 
depending on the color space being used. 

Audio Level Warning
Customizes the audio level warning threshold, which can vary depending on the 
country standard.

NETWORK Tab
The Network settings are used to configure the two network interface cards 
(NICs) installed in the HDR Image Analyzer chassis. 
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Figure 35.  Setting Screen, Network Tab

SAFE AREA Tab
These settings are used to customize the Safe Area box displays, including the 
ability to choose which (or both) regions to display.
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Figure 36.  Settings Screen, Safe Area Tab

The Safe Area parameters are saved in Setups. 
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Chapter 6 – Menu Reference

Analyzer Menu Guide
Table 2.  Analyzer Menu > Analyzer Mode

Sub Menu Menu Option 1 Description Keyboard 
Shortcut 

Analyzer Mode Waveform Luminance Select Luminance Waveform CTRL+F1 

Waveform Lumi Color Select Luminance Waveform with Colors CTRL+F2 

Waveform Color Select Color Waveform CTRL+F3 

Waveform RGB Color Select RGB Color Waveform CTRL+F4 

Waveform RGB Select RGB Waveform CTRL+F5 

Waveform YCbCr Select YCbCr Waveform CTRL+F6 

Waveform YRGB Select YRGB Waveform CTRL+F7

Histogram Luminance Select Histogram Luminance CTRL+F8

Histogram Color Select Histogram Color CTRL+F9

Image Show Single View video image F1

Waveform Show Single View Waveform F2 

Gamut Show Single View Gamut F3 

Vectorscope Show Single View Vectorscope F4 

Combined with Audio Show Quadrants with Audio (either Phase or Level) F5 

Combined with Pixel Picker Show Quadrants with Color Picker F6 

Combined with Vectorscope Show Quadrants with Vectorscope F7 

Combined with Log Show Quadrants with Log F8 

Combined with Info Page Show Quadrants with Info Page F9

Single Line Mode Enable Single Line Mode CTRL+space
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Table 3.  Analyzer Menu > Analyzer Colorspace, White Point Compensation, 
False Color, YCbCr Matrix, White Point

Menu Menu Option 1 Menu Option 2 Description Keyboard 
Shortcut 

Analyzer 
Colorspace

Auto HDR mode 
change

When On, color space is adjusted automatically 
according to the SDI flagging between Rec.709, HLG 
Rec.2020 and HDR Rec.

Camera Arri LogC Wide 
Gamut

Set Arri LogC Wide Gamut colorspace

Canon Log2 Set Canon Log2 colorspace

Canon Log3 Set Canon Log3 colorspace

Panasonic VLog/
Gamut 

Set Panasonic VLog/Gamut colorspace

Red WideGamut/
Log3G10 

Set Red WideGamut/Log3G10 colorspace

Sony SLog3/
BT2020

Set Sony SLog3/BT2020 colorspace

Sony SLog3/
SGamut3

Set Sony SLog3/SGamut3 colorspace

Sony SLog3/
SGamut3Cine

Set Sony SLog3/SGamut3Cine colorspace

SDR Rec709 Set SDR Rec709 colorspace CTRL+F10

P3DCI Set SDR P3DCI colorspace

P3D65 Set SDR P3D65 colorspace

Rec2020 Set SDR Rec2020 colorspace

XYZ DCI Set SDR XYZ DCI colorspace

HLG Rec709 Set HLG Rec709 colorspace

Rec2020 Set HLG Rec2020 colorspace CTRL+F11

HDR Rec709 Set HDR Rec709 colorspac

P3D65 Set HDR RecP3D65 colorspace

Rec2020 Set HDR Rec2020 colorspace CTRL+F12

White Point 
Compensation

Off No white point compensation

D65 Apply D65 white point compensation to the analysis.

False Color Brightness Apply false color to entire Brightness ALT+F1

Brightness 
Warning

Apply false color to Brightness above warning level ALT+F2

Gamut Apply false color to entire Gamut ALT+F3

Gamut Warning Apply false color to Gamut above warning level ALT+F4

Off No false color ALT+F5

YCbCr Matrix Rec709 Image is converted to the YUV space, using Rec709.

Rec2020 Image is converted to the YUV space, using Rec2020.

White Point D65 Display a box on the CIE xy graph showing the 
position of the D65 white point. Analysis is not 
affected.

DCI Display a box on the CIE xy graph showing the 
position of the DCI white point. Analysis is not 
affected.

Off Hide the white point box on the CIE xy graph.
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Table 4.  Analyzer Mode > Vectorscope Target, Waveform Graticule, Scope and 
Display LUTs, Analyzer Gain, Zoom, Pixels View

Menu Menu Option 1 Description Keyboard 
Shortcut 

Vectorscope 
Target

75%

100%

Waveform 
Graticule

Default

Code Values

Analyzer Scope 
LUT 

NoLUT No LUT applied to input signal.

(selection list) Optionally apply a variety of LUTs to the input signal being 
analyzed.

Analyzer 
Display LUT 

Display LUT No LUT applied to display signal.

Auto The LUT is automatically selected in a way that the incoming 
image looks correct on a 709 SDR monitor. 

(selection list) Optionally apply a variety of LUTs to the displayed video image, 
analysis is not affected.

Analyzer Gain Increase Gain Simple increase of display gain. CTRL+NumPad 
Plus Sign

Decrease Gain Simple decrease of display gain. CTRL+NumPad 
Minus Sign

Reset Gain Simple reset of display gain. CTRL+ENTER

Zoom Vectorscope Zoom Apply a 5x magnification to the Vectorscope display. CTRL+v

Waveform Zoom Apply a 4x magnification to the Waveform display. CTRL+w

Pixels View Hexadecimal Color picker displays hexadecimal values

Decimal Color picker displays decimal values

Nits Color picker displays nits (RGB only)

Table 5.  Analyzer Mode > Audio, Timecode, SafeArea

Menu Menu Option 1 Menu Option 2 Description Keyboard 
Shortcut 

Audio Phase Meter Channel 1-2 Show audio phase between Ch 1& 2

Channel 3-4 Show audio phase between Ch 3&4

Channel 5-6 Show audio phase between Ch 5&6

Channel 7-8 Show audio phase between Ch 7&8

Channel 1-8 Show four phase diagrams of Ch 1&2, thru Ch 7&8

Channel 9-16 Show four phase diagrams of Ch 9&10, thru Ch 15&16

Level Meter Display Level Meter

Timecode 
on Image

Enable (on/off) Show Timecode box on the image. CTRL+t

SafeArea on 
Image

Enable (on/off) Show framing guides on the image. CTRL+s

System 
Shutdown

Closes the application and powers off the system.

System 
Restart

Restarts the system and automatically relaunches the 
application.

Application 
Restart

Restarts the application without shutting down the 
system.
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Setup Menu Guide
Table 6.  Analyzer Mode > Audio, Timecode, SafeArea

Menu Menu Option 1 Description Keyboard 
Shortcut 

Manage 
LUTs

Load New LUT Opens the Windows Explorer browser used to navigate to and load a 3d 
Mesh or a .cube LUT file. 

Delete LUT Opens a list of the currently loaded LUTs that you can select for deletion.

Delete All LUTs Deletes all currently loaded LUTs.

Create 
Setup

Opens a dialog box for naming and saving a new Setup file. This file will have 
the current operational settings.

Open 
Setup

analyzer Selects the "analyzer" Setup file, which is the original setup file which may 
have been changed.

(selection list) Reloads the selected Setup file.

Delete 
Setup

Deletes the currently open Setup file.

Reset 
Setup

Resets the currently open Setup file to factory defaults.

Video Menu Guide
Table 7.  Video Menu Options

Menu Menu Option 1 Menu Option 2 Description Keyboard 
Shortcut 

Resolution HD HD YCbCr 10Bit 
HD RGB 10 Bit 
HD RGB 12 Bit 
HD RGB Dual-Link 10Bit 
HD RGB Dual-Link 12Bit

Defines an HD input video signal.

2K 2K YCbCr 10Bit 
2K RGB 10 Bit 
2K RGB 12 Bit 
2K RGB Dual-Link 10Bit 
2K RGB Dual-Link 12Bit

Defines a 2K input video signal.

UHD UHD YCbCr 10Bit 
UHD RGB 10 Bit 
UHD RGB 12 Bit 
UHD Two-Wires Square 10Bit 
UHD Two-Wires 2SI 10Bit

Defines a UHD input video signal.

4K 4K YCbCr 10Bit 
4K RGB 10 Bit 
4K RGB 12 Bit 
4K Two-Wires Square 10Bit 
4K Two-Wires 2SI 10Bit

Defines a 4K input video signal

AutoDetect 
Options

Auto Mode Automatically detects input video 
links

Forces 1x SDI Connection 
Mode

Forces single link input.

Forced 4x SDI Connection 
Mode

Forces four link input.

AutoDetect Toggles Auto Detect of the 
incoming video resolution 
On or Off.
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Menu Menu Option 1 Menu Option 2 Description Keyboard 
Shortcut 

Capture Capture 1 Captures current image and stores in 
memory 1

ALT+NumPad 1

Capture 2 Captures current image and stores in 
memory 2

ALT+NumPad 2

Capture 3 Captures current image and stores in 
memory 3

ALT+NumPad 3

Capture 4 Captures current image and stores in 
memory 4

ALT+NumPad 4

Recall Show Live Show live video signal CTRL+NumPad 5

Show Captured 1 Show memory 1 CTRL+NumPad 1

Recall › Show 
Captured 2

Show memory 2 CTRL+NumPad 2

Recall › Show 
Captured 3

Show memory 3 CTRL+NumPad 3 

Recall › Show 
Captured 4

Show memory 4 CTRL+NumPad 4

Screenshot Save Screenshot Captures a screenshot of the 
Analyser UI to the host computer. 

CTRL+e

Copy Screenshot

(Opens a file 
browser for 
selection of a 
folder to copy to.) 

Copy All Copies all captured screenshots into 
the selected folder.

Copy Today's Copies only screenshots captured 
today into the selected folder.

Copy All Except Today's Copies all screenshots except those 
captured today into the selected 
folder

Delete Screenshot Delete All Deletes all captured screenshots 
from the host computer.

Delete Today's Deletes only screenshots captured 
today from the host computer.

Delete All Except Today's Deletes all screenshots except 
those captured today from the host 
computer.

Log Menu Guide
Table 8.  Log Menu Options

Menu Menu Option 1 Description Keyboard 
Shortcut 

Start Log To File Creates a new log file for a new QC session on disk CTRL+l

Reset Log Data Clears current log data. CTRL+d

Copy Logs Copy All Log Files

Copy Today's Log Files

Copy All Except Today's 
Log Files

Delete Logs Delete All Log Files

Delete Today's Log Files

Delete All Except 
Today's Log Files
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Menu Menu Option 1 Description Keyboard 
Shortcut 

Timestamp Comments in the Log Window to be tagged based on session 
clock.

Timecode Comments in the Log Window to be tagged based on SDI time 
code.

Auto 
Timecode/
Timestamp

Shows timecode, timestamp, or both in the Log Window if the 
information is present on the incoming signal.

Timestamp - 
Timecode

Show both time stamps with session clock priority.

Timecode - 
Timestamp

Show both time stamps with SDI time code priority.

Help Menu Guide
Table 9.  Help Menu Options

Menu Description Keyboard 
Shortcut 

About Displays the Application name and Version information. ALT+Forward Slash(/)

Update 
Analyzer

Opens a browser allowing HDR Image Analyzer software update.

License Utility Future use.

Other Keyboard Shortcuts
Keyboard Shortcut Description

ALT+h Hide all popup windows (i.e. Help, Performance)

CONTROL+p Show/Hide Performance window

CTRL + Up/Down Arrow Moves the single line mode analysis up and down one line at the time.
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Appendix A – Specifications

HDR Image Analyzer Specs
Video Formats

•	 (4K) 4096 x 2160p 23.98, 24, 25, 29.97, 30, 48 A/B, 50 A/B, 59.94 A/B, 60 A/B
•	 (UltraHD) 3840 x 2160p 23.98, 24, 25, 29.97, 30, 48 A/B, 50 A/B, 59.94 A/B, 60 

A/B
•	 (2K) 2048 x 1080p 23.98, 24, 25, 29.97, 30, 48 A/B, 50 A/B, 59.94 A/B, 60 A/B
•	 (2K) 2048 x 1080PsF 23.98, 24, 25, 29.97, 30, 48 A/B, 50 A/B, 59.94 A/B, 60 A/B
•	 (HD) 1080i 50, 59.94, 60
•	 (HD) 1080PsF 23.98, 24, 25, 29.97, 30
•	 (HD) 1080p 23.98, 24, 25, 29.97, 30, 50 A/B, 59.94 A/B, 60 A/B
•	 (HD) 720p 50, 50.94, 60 

Video Input Digital 
•	 4x 3G-SDI BNC

Video Output Digital
•	 4x 3G-SDI BNC

Audio Input Digital
•	 16-Channel 24-bit SDI embedded, 48 kHz synchronous

Audio Output Digital
•	 16-Channel 24-bit SDI embedded, 48 kHz synchronous

Computer Monitor Output
•	 DisplayPort Output:

•	 Up to UltraHD 60p

Reference Input
•	 Signal: Analog video sync (Blackburst or Tri-Level)

Size: (w x d x h)
•	 1RU form factor
•	 17.2” x 16.9" x 1.7" (436.88 x 429.26 x 43.18 mm) 

Weight
•	 28 lb (12.7kg) in box
•	 18 lb (8.2kg) server only

Power
•	 100-240 VAC 50/60 Hz (Dual, redundant power supplies)
•	 190W typical, 245W Maximum
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Environment
•	 Safe Operating Temperature: 5 to 35 C (41 to 95 F)
•	 Safe Storage Temperature (Power OFF): -40 to 60 C (-40 to 140 F) 
•	 Operating Relative Humidity: 8-90% noncondensing 
•	 Nonoperating Relative Humidity: 5-95% noncondensing
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Appendix B – Safety and Compliance 
Federal Communications Commission (FCC) Compliance Notices

Class A Interference Statement

This equipment has been tested and found to comply with the limits for a Class 
A digital device, pursuant to Part 15, Subpart B of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following 
measures:

•	 Reorient or relocate the receiving antenna.
•	 Increase the separation between the equipment and receiver.
•	 Connect the equipment into an outlet on a circuit different from that to which 

the receiver is connected.
•	 Consult the dealer or an experienced radio/TV technician for help.

FCC Caution

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful interference, and 
(2) this device must accept any interference received, including interference that 
may cause undesired operation.

Canadian ICES Statement
Canadian Department of Communications Radio Interference Regulations

This digital apparatus does not exceed the Class A limits for radio-noise emissions 
from a digital apparatus as set out in the Radio Interference Regulations of 
the Canadian Department of Communications. This Class A digital apparatus 
complies with Canadian ICES-003.

Règlement sur le brouillage radioélectrique du ministère des Communications

Cet appareil numérique respecte les limites de bruits radioélectriques visant les 
appareils numériques de classe A prescrites dans le Règlement sur le brouillage 
radioélectrique du ministère des Communications du Canada. Cet appareil 
numérique de la Classe A est conforme à la norme NMB-003 du Canada.

European Union and European Free Trade Association (EFTA) 
Regulatory Compliance

This equipment may be operated in the countries that comprise the member 
countries of the European Union and the European Free Trade Association. These 
countries, listed in the following paragraph, are referred to as The European 
Community throughout this document:

AUSTRIA, BELGIUM, BULGARIA, CYPRUS, CZECH REPUBLIC, DENMARK, ESTONIA, 
FINLAND, FRANCE, GERMANY, GREECE, HUNGARY, IRELAND, ITALY, LATVIA, 
LITHUANIA, LUXEMBOURG, MALTA, NETHERLANDS, POLAND, PORTUGAL, 
ROMANIA, SLOVAKIA, SLOVENIA, SPAIN, SWEDEN, UNITED KINGDOM, ICELAND, 
LICHTENSTEIN, NORWAY, SWITZERLAND
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Declaration of Conformity

Marking by this symbol indicates compliance with the Essential Requirements of 
the EMC Directive of the European Union 2014/30/EU.

 This equipment meets the following conformance standards:

EN 60065: 2014 (T-Mark License),

IEC 60065: 2014 (CB Scheme Report/Certificate) 

Additional licenses issued for specific countries available on request.

Emissions

EN 55032: 2012 + AC: 2013, CISPR 32: 2015,

EN 61000-3-2: 2014, EN 61000-3-3: 2013

Immunity

EN 55103-2: 2009, EN 61000-4-2:2009, EN 61000-4-3: 2006 + A1:2008 + A2:2010,

EN 61000-4-4: 2004 + A1:2010, EN 61000-4-5:2006, EN 61000-4-6:2009, 

EN 61000-4-11:2004

Environments: E2, E3 and E4

The product is also licensed for additional country specific standards as required 
for the International Marketplace.

Warning! This is a Class A product. In a domestic environment, this product 
may cause radio interference, in which case, the user may be required to take 
appropriate measures.

Achtung! Dieses ist ein Gerät der Funkstörgrenzwertklasse A. In Wohnbereichen 
können bei Betrieb dieses Gerätes Rundfunkstörungen auftreten, in welchen 
Fällen der Benutzer für entsprechende Gegenmaßnahmen verantwortlich ist.

Attention! Ceci est un produit de Classe A. Dans un environnement domestique, 
ce produit risque de créer des interférences radioélectriques, il appartiendra 
alors à l?utilisateur de prendre les mesures spécifiques appropriées..

Recycling Notice

This symbol on the product or its packaging indicates that this product 
must not be disposed of with your other household waste. Instead, it is your 
responsibility to dispose of your waste equipment by handing it over to a 
designated collection point for the recycling of waste electrical and electronic 
equipment. The separate collection and recycling of your waste equipment 
at the time of disposal will help conserve natural resources and ensure that 
it is recycled in a manner that protects human health and the environment. 
For more information about where you can drop off your waste for recycling, 
please contact your local authority, or where you purchased your product.

Korea KCC Compliance Statement

A급 기기
(업무용 방송통신기자재)

Class A 
(Broadcasting Communication 
Equipment for Office Use) 

이 기기는 업무용(A급) 전자파적합기기로서 판매자 또는 사용자는
이 점을 주의하시기 바라며, 가정외의 지역에서 사용하는 것을
목적으로 합니다.

As an electromagnetic wave equipment for office use (Class A),  
this equipment is intended to use in other than home area. 
Sellers or users need to take note of this. 
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Taiwan Compliance Statement

This is a Class A product based on the standard of the Bureau of Standards, 
Metrology and Inspection (BSMI) CNS 13438, Class A. In a domestic environment 
this product may cause radio interference in which case the user may be required 
to take adequate measures.

Japan Compliance Statement

This is a Class A product based on the standard of the VCCI Council (VCCI 32: 2016). 
If this equipment is used in a domestic environment, radio interference may 
occur, in which case, the user may be required to take corrective actions.

China Compliance Statement 
This product has been tested to the following Chinese standards:

GB/T13837-2012, GB8898-2011, and GB17625.1-2012 

This product meets the requirements of implementation rules for compulsory 
certification (REF NO. CNCA-C08-01:2014) under certificate number 
2019010805151936

Translated Warning and Caution Messages
The following caution statements, warning conventions, and warning messages 
apply to this product and manual.

Before Operation Please Read These Instructions

Warning! Read and follow all warning notices and instructions marked on the 
product or included in the documentation.

Avertissement! Lisez et conformez-vous à tous les avis et instructions 
d'avertissement indiqués sur le produit ou dans la documentation.

Warnung! Lesen und befolgen Sie die Warnhinweise und Anweisungen, die auf 
dem Produkt angebracht oder in der Dokumentation enthalten sind.

¡Advertencia! Lea y siga todas las instrucciones y advertencias marcadas en el 
producto o incluidas en la documentación.

Aviso! Leia e siga todos os avisos e instruções assinalados no produto ou incluídos 
na documentação.

Avviso! Leggere e seguire tutti gli avvisi e le istruzioni presenti sul prodotto o 
inclusi nella documentazione. 
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Warning! Do not use this device near water and clean only with a dry cloth.
Avertissement! N'utilisez pas cet appareil près de l'eau et nettoyez-le seulement 

avec un tissu sec.
Warnung! Das Gerät nicht in der Nähe von Wasser verwenden und nur mit einem 

trockenen Tuch säubern.
¡Advertencia! No utilice este dispositivo cerca del agua y límpielo solamente con 

un paño seco.
Aviso! Não utilize este dispositivo perto da água e limpe-o somente com um pano 

seco.
Avviso! Non utilizzare questo dispositivo vicino all'acqua e pulirlo soltanto con un 

panno asciutto. 

Warning! Do not block any ventilation openings. Install in accordance with the 
manufacturer's instructions.

Avertissement! Ne bloquez aucune ouverture de ventilation. Suivez les 
instructions du fabricant lors de l'installation.

Warnung! Die Lüftungsöffnungen dürfen nicht blockiert werden. Nur gemäß den 
Anweisungen des Herstellers installieren.

¡Advertencia! No bloquee ninguna de las aberturas de la ventilación. Instale de 
acuerdo con las instrucciones del fabricante.

Aviso! Não obstrua nenhuma das aberturas de ventilação. Instale de acordo com as 
instruções do fabricante.

Avviso! Non ostruire le aperture di ventilazione. Installare in conformità con le 
istruzioni del fornitore. 

Warning! Do not install near any heat sources such as radiators, heat registers, 
stoves, or other apparatus (including amplifiers) that produce heat.

Avertissement! N'installez pas l'appareil près d'une source de chaleur telle que des 
radiateurs, des bouches d'air de chauffage, des fourneaux ou d'autres appareils 
(amplificateurs compris) qui produisent de la chaleur.

Warnung! Nicht in der Nähe von Wärmequellen wie Heizkörpern, Heizregistern, 
Öfen oder anderen Wärme erzeugenden Geräten (einschließlich Verstärkern) 
aufstellen.

¡Advertencia! No instale cerca de fuentes de calor tales como radiadores, registros 
de calor, estufas u otros aparatos (incluidos amplificadores) que generan calor.

Aviso! Não instale perto de nenhuma fonte de calor tal como radiadores, saídas de 
calor, fogões ou outros aparelhos (incluindo amplificadores) que produzam calor.

Avviso! Non installare vicino a fonti di calore come termosifoni, diffusori di aria 
calda, stufe o altri apparecchi (amplificatori compresi) che emettono calore 
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Warning! Do not defeat the safety purpose of the polarized or grounding-
type plug. A polarized plug has two blades with one wider than the other. A 
grounding type plug has two blades and a third grounding prong. The wide 
blade or the third prong are provided for your safety. If the provided plug does 
not fit into your outlet, consult an electrician for replacement of the obsolete 
outlet.

Avertissement! La sécurité de la prise polarisée ou de la prise de type mise à la 
terre ne doit en aucun cas être empêchée de fonctionner. Une prise polarisée 
a deux broches, l'une étant plus large que l'autre. Une prise de type mise à la 
terre a deux broches et une troisième broche pour la mise à la terre. La broche 
large ou la troisième broche sont fournies pour votre sécurité. Si la prise 
fournie ne s'insère pas dans votre prise femelle, consultez un électricien pour le 
remplacement de la prise femelle obsolète.

Warnung!  Der Sicherheitszweck des gepolten bzw. Schukosteckers ist zu 
berücksichtigen. Ein gepolter Stecker verfügt über zwei Pole, von denen einer 
breiter als der andere ist. Ein Schukostecker verfügt neben den zwei Polen noch 
über einen dritten Pol zur Erdung. Der breite Pol bzw. der Erdungspol dienen der 
Sicherheit. Wenn der zur Verfügung gestellte Stecker nicht in Ihren Anschluss 
passt, konsultieren Sie einen Elektriker, um den veralteten Anschluss zu ersetzen.

¡Advertencia! No eche por tierra la finalidad del tipo de enchufe polarizado con 
conexión a tierra. Un enchufe polarizado tiene dos espigas, una más ancha 
que la otra. Un enchufe con conexión a tierra tiene dos espigas iguales y una 
tercera espiga que sirve para la conexión a tierra. La expiga ancha, o la tercera 
espiga, sirven para su seguridad. Si el enchufe suministrado no encaja en el 
tomacorriente, consulte con un electricista para reemplazar el tomacorriente 
obsoleto.

Aviso! Não anule a finalidade da segurança da ficha polarizada ou do tipo ligação 
terra. Uma ficha polarizada tem duas lâminas sendo uma mais larga do que 
a outra. Uma ficha do tipo de ligação à terra tem duas lâminas e um terceiro 
terminal de ligação à terra. A lâmina larga ou o terceiro terminal são fornecidos 
para sua segurança. Se a ficha fornecida não couber na sua tomada, consulte um 
electricista para a substituição da tomada obsoleta.

Avviso! Non compromettere la sicurezza della spina polarizzata o con messa a 
terra. Una spina polarizzata ha due spinotti, di cui uno più largo. Una spina con 
messa a terra ha due spinotti e un terzo polo per la messa a terra. Lo spinotto 
largo o il terzo polo sono forniti per motivi di sicurezza. Se la spina fornita non 
si inserisce nella presa di corrente, contattare un elettricista per la sostituzione 
della presa obsoleta.

Warning! Since the Mains plug is used as the disconnection for the device, it must 
remain readily accessible and operable.

Avertissement! Puisque la prise principale est utilisée pour débrancher l'appareil, 
elle doit rester aisément accessible et fonctionnelle.

Warnung! Da der Netzstecker als Trennvorrichtung dient, muss er stets zugänglich 
und funktionsfähig sein.

¡Advertencia! Puesto que el enchufe de la red eléctrica se utiliza como dispositivo 
de desconexión, debe seguir siendo fácilmente accesible y operable.

Aviso! Dado que a ficha principal é utilizada como a desconexão para o dispositivo, 
esta deve manter-se prontamente acessível e funcional.

Avviso! Poiché il cavo di alimentazione viene usato come dispositivo di 
sconnessione, deve rimane prontamente accessibile e operabile.
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Warning! Protect the power cord from being walked on or pinched particularly at 
plugs, convenience receptacles, and the point where they exit from the device.

Avertissement! Protégez le cordon d'alimentation pour que l'on ne marche 
pas dessus ou qu'on le pince, en particulier au niveau des prises mâles, des 
réceptacles de convenance, et à l'endroit où il sort de l'appareil.

Warnung! Vermeiden Sie, dass auf das Netzkabel getreten oder das Kabel geknickt 
wird, insbesondere an den Steckern, den Steckdosen und am Kabelausgang am 
Gerät.

¡Advertencia! Proteja el cable de energía para que no se le pise ni apriete, en 
especial cerca del enchufe, los receptáculos de conveniencia y el punto del que 
salen del equipo.

Aviso! Proteja o cabo de alimentação de ser pisado ou de ser comprimido 
particularmente nas fichas, em tomadas de parede de conveniência e no ponto 
de onde sai do dispositivo.

Avviso! Proteggere il cavo di alimentazione in modo che nessuno ci cammini sopra 
e che non venga schiacciato soprattutto in corrispondenza delle spine e del 
punto in cui esce dal dispositivo. 

Warning! Unplug this device during lightning storms or when unused for long 
periods of time.

Avertissement! Débranchez cet appareil pendant les orages avec éclairsou s'il est 
inutilisé pendant de longues périodes.

Warnung! Das Gerät ist bei Gewitterstürmen oder wenn es über lange Zeiträume 
ungenutzt bleibt vom Netz zu trennen.

¡Advertencia! Desenchufe este dispositivo durante tormentas eléctricas o cuando 
no se lo utilice por largos periodos del tiempo.

Aviso! Desconecte este dispositivo da tomada durante trovoadas ou quando não é 
utilizado durante longos períodos de tempo.

Avviso! Utilizzare soltanto i collegamenti e gli accessori specificati e/o venduti dal 
produttore, quali il treppiedi e l'esoscheletro. 
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Warning! Refer all servicing to qualified service personnel. Servicing is required 
when the device has been damaged in any way, such as power-supply cord or 
plug is damaged, liquid has been spilled or objects have fallen into the device, 
the device has been exposed to rain or moisture, does not operate normally, or 
has been dropped.

Avertissement! Référez-vous au personnel de service qualifié pour tout entretien. 
L'entretien est exigé quand l'appareil a été endommagé de quelque manière 
que ce soit, par exemple lorsque le cordon d'alimentation ou la prise sont 
endommagés, que du liquide a été versé ou des objets sont tombés dans 
l'appareil, que l'appareil a été exposé à la pluie ou à l'humidité, ne fonctionne pas 
normalement ou est tombé.

Warnung! Das Gerät sollte nur von qualifizierten Fachkräften gewartet werden. 
Eine Wartung ist fällig, wenn das Gerät in irgendeiner Weise beschädigt wurde, 
wie bei beschädigtem Netzkabel oder Netzstecker, falls Flüssigkeiten oder 
Objekte in das Gerät gelangen, das Gerät Regen oder Feuchtigkeit ausgesetzt 
wurde, nicht ordnungsgemäß funktioniert oder fallen gelassen wurde.

¡Advertencia! Consulte al personal calificado por cuestiones de reparación. El 
servicio de reparación se requiere cuando el dispositivo ha recibido cualquier 
tipo de daño, por ejemplo cable o espigas dañadas, se ha derramado líquido o 
se han caído objetos dentro del dispositivo, el dispositivo ha sido expuesto a la 
lluvia o humedad, o no funciona de modo normal, o se ha caído.

Aviso! Remeta todos os serviços de manutenção para o pessoal de assistência 
qualificado. A prestação de serviços de manutenção é exigida quando o 
dispositivo foi danificado mediante qualquer forma, como um cabo de 
alimentação ou ficha que se encontra danificado/a, quando foi derramado 
líquido ou caíram objectos sobre o dispositivo, quando o dispositivo foi exposto 
à chuva ou à humidade, quando não funciona normalmente ou quando foi 
deixado cair.

Avviso! Fare riferimento al personale qualificato per tutti gli interventi di assistenza. 
L'assistenza è necessaria quando il dispositivo è stato danneggiato in qualche 
modo, ad esempio se il cavo di alimentazione o la spina sono danneggiati, è 
stato rovesciato del liquido è stato rovesciato o qualche oggetto è caduto nel 
dispositivo, il dispositivo è stato esposto a pioggia o umidità, non funziona 
correttamente o è caduto 

Warning! Do not open the chassis. There are no user-serviceable parts inside. 
Opening the chassis will void the warranty unless performed by an AJA service 
center or licensed facility.

Avertissement! Ne pas ouvrir le châssis. Aucun élément à l’intérieur du châssis 
ne peut être réparé par l’utilisateur. La garantie sera annulée si le châssis est 
ouvert par toute autre personne qu’un technicien d’un centre de service ou d’un 
établissement agréé AJA.

Warnung! Öffnen Sie das Gehäuse nicht. Keine der Geräteteile können vom 
Benutzer gewartet werden. Durch das Öffnen des Gehäuses wird die Garantie 
hinfällig, es sei denn, solche Wartungsarbeiten werden in einem AJA-Service-
Center oder einem lizenzierten Betrieb vorgenommen.

¡Advertencia! No abra el chasis. El interior no contiene piezas reparables por el 
usuario. El abrir el chasis anulará la garantía a menos que se lo haga en un centro 
de servicio AJA o en un local autorizado.

Advertência! Não abra o chassi. Não há internamente nenhuma peça que permita 
manutenção pelo usuário. Abrir o chassi anula a garantia, a menos que a abertura 
seja realizada por uma central de serviços da AJA ou por um local autorizado.

Avvertenza! Non aprire lo chassis. All’interno non ci sono parti riparabili 
dall’utente. L’apertura dello chassis invaliderà la garanzia se non viene effettuata 
da un centro ufficiale o autorizzato AJA. 
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Warning! Disconnect the external AC power supply line cord(s) from the mains 
power before moving the unit.

Avertissement! Retirez le ou les cordons d’alimentation en CA de la source 
d’alimentation principale lorsque vous déplacez l’appareil. 

Warnung! Trennen Sie die Wechselstrom-Versorgungskabel vom Netzstrom, bevor 
Sie das Gerät verschieben.

¡Advertencia! Cuando mueva la unidad desenchufe de la red eléctrica el/los 
cable(s) de la fuente de alimentación CA tipo brick.

Advertência! Remova os cabos CA de alimentação brick da rede elétrica ao mover 
a unidade.

Avvertenza! Scollegare il cavo dell’alimentatore quando si sposta l’unità.

Warning! Only use attachments and accessories specified and/or sold by the 
manufacturer.

Avertissement! Utilisez seulement les attaches et accessoires spécifiés et/ou 
vendus par le fabricant.

Warnung! Verwenden Sie nur Zusatzgeräte und Zubehör angegeben und / oder 
verkauft wurde durch den Hersteller.

¡Advertencia! Utilice solamente los accesorios y conexiones especificados y/o 
vendidos por el fabricante.

Aviso! Utilize apenas equipamentos/acessórios especificados e/ou vendidos pelo 
fabricante.

Avviso! Utilizzare soltanto i collegamenti e gli accessori specificati e/o venduti dal 
produttore. 

Hazard! High Voltage. This situation or condition can cause injury due to electric 
shock.

Avertissement! Tension élevée. Cette situation ou condition peut causer des 
blessures dues à un choc électrique.

Warnung!  Hochspannung. Diese Situation oder Bedingung kann zu Verletzungen 
durch Stromschlag führen. 

¡Advertencia!  Alto voltaje . Esta situación o condición puede causar lesiones 
debidas a una descarga eléctrica.

Aviso!  Alta Tensão . Esta situação ou condição pode causar danos devido a 
choques elétricos.

Avviso!  Alta tensione. Questa situazione o condizione può causare lesioni a causa 
di scosse elettriche.

Warning! Dual Power Cord Notice—please read this. To reduce the risk of electrical 
shock,disconnect both power cords before servicing equipment.

Avertissement! Avis concernant la double alimentation électrique — à lire 
soigneusement. Pour éviter tout risque d’électrocution, débranchez les deux 
câbles électriques avant d’intervenir sur l’équipement.

Achtung! Hinweis auf Doppel-Netzkabel—bitte lesen. Um das Risiko eines 
Elektroschocks zu verringern, müssen beide Netzkabel ausgestöpselt werden, 
bevor die Vorrichtung gewartet wird.

Avvertenza. Avviso concernente il cavo di alimentazione doppio – leggere 
attentamente. Per ridurre il rischio di elettrocuzione, scollegare entrambi i cavi 
di alimentazione prima di eseguire la manutenzione o riparazioni di questo 
apparecchio.

Aviso! Aviso de Cabo Elétrico Duplo - por favor, leia isto. Para reduzir o risco 
de choque elétrico, desconecte ambos os cabos elétricos antes de fazer 
manutenção ao equipamento.

¡Advertencia! Aviso del doble cable de alimentación - leer esto por favor. 
Para reducir el riesgo de descarga eléctrica, desconecte ambos cables de 
alimentación antes de dar servicio al equipo.
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Caution! To meet safety regulations for leakage current, connect the dual power 
supplies to separate branch circuits.

¡Advertencia! Para cumplir con las normas de seguridad para la corriente de fuga, 
conecte las dos fuentes de alimentación para circuitos derivados diferentes.

Attention! Pour répondre aux mesures de sécurité concernant le courant de 
fuite, raccorder les sources d'alimentation doubles à des circuits de dérivation 
distincts.

Warnung! Zur Erfüllung der Sicherheitsbestimmungen bezüglich Reststrom 
schließen Sie bitte die zwei Netzteile an unterschiedlichen Abzweigleitungen an.

Cuidado! Para atender aos regulamentos de segurança para correntes de fuga, 
conecte as fontes duplas a circuitos elétricos separados.

Attenzione! Per soddisfare le norme di sicurezza sulla corrente di perdita, 
collegare i doppi alimentatori a circuiti derivati separati.

Warning! Hazardous Voltages! The safe operation of this product requires that a 
protective earth connection be provided. This protective earth is provided by 
the grounding conductor in the equipment's supply cord. To reduce the risk of 
electrical shock to operator and service personnel, this ground conductor must 
be connected to an earthed ground.

Avertissement : tensions dangereuses — Pour utiliser ce produit en toute sécurité, 
il faut un raccordement à la terre. Ce raccordement s’effectue par l’intermédiaire 
du connecteur de terre dans le cordon d’alimentation de l’équipement. Pour 
réduire le risque d’électrocution de l’opérateur ou du personnel de maintenance, 
ce cordon avec conducteur de terre doit être branché sur une prise reliée à la 
terre.

Achtung! Gefährliche Spannungen — Sichere Bedienung dieses Geräts erfordert, 
dass ein Schutzleiteranschluss vorgesehen wird. Dieser Schutzleiteranschluss 
wird mittels der Erdungsleitung im Netzkabel der Vorrichtung vorgesehen. 
Um die Gefahr eines Elektroschocks für Bedien- und Wartungspersonal zu 
verringern, muss diese Erdungsleitung mit einer geerdeten Masse verbunden 
werden.

Avvertenza – Alte tensioni – Il funzionamento in sicurezza di questo prodotto 
richiede una presa di terra, che viene fornita dal conduttore di messa a terra 
presente nel cavo di alimentazione dell’apparecchio. Per ridurre il rischio di 
elettrocuzione per l’operatore e il personale di manutenzione, tale conduttore 
deve essere collegato a un punto al potenziale di terra.

Advertencia de voltajes peligrosos — El funcionamiento seguro de este producto 
require que se proporcione una conexión terrestre protegida. Esta protección 
terrestre es proporcionada por el conductor de conexión en la tierra del cable de 
alimentación del equipo. Para reducir el riesgo de descarga eléctrica al operador 
y el personal de servicio, este conductor de conexión de la tierra debe ser 
conectado a la misma tierra.
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Colorfront Copyright Notices
Freetype 2.3.9, 2.3.5

FreeType License (FTL)

Copyright © 2008 The FreeType Project (HYPERLINK "https://protect-us.mimecast.
com/s/GrHNC68zR0IWmW4i6fpI5" \t "_blank" www.freetype.org). All rights 
reserved.

HYPERLINK "https://protect-us.mimecast.com/s/p4YKC73WLAhRNRBUBNmyL" \t 
"_blank" http://www.freetype.org/FTL.TXT

FTGL - OpenGL font library 2.1.3

GNU LESSER GENERAL PUBLIC LICENSE

Version 2.1, February 1999

Copyright © 2001-2004 Henry Maddocks <HYPERLINK "mailto:ftgl@opengl.geek.
nz" \t "_blank" ftgl@opengl.geek.nz>

Copyright © 2008 Sam Hocevar <HYPERLINK "mailto:sam@zoy.org" \t "_blank" 
sam@zoy.org>

Copyright © 2008 Sean Morrison <HYPERLINK "mailto:learner@brlcad.org" \t 
"_blank" learner@brlcad.org>

HYPERLINK "https://protect-us.mimecast.com/s/SOzVC82B69ukqkytM7qV0" \t 
"_blank" http://ftgl.sourceforge.net/docs/html/index.html

Inconsolata font

SIL OPEN FONT LICENSE

Version 1.1 - 26 February 2007

Created by Raph Levien using his own tools and FontForge. Copyright 2006 Raph 
Levien. Released under the SIL Open Font License, HYPERLINK "https://protect-us.
mimecast.com/s/cuUpC9rLQ2hOqOwHPJLAe" \t "_blank" http://scripts.sil.org/
OFL.

Python 2.7

HYPERLINK "https://protect-us.mimecast.com/s/iiVqC0RXV9uyByAt3o0C6" \t 
"_blank" BEOPEN.COM LICENSE AGREEMENT FOR PYTHON 2.0

Copyright © 2001-2019 Python Software Foundation; All Rights Reserved

HYPERLINK "https://protect-us.mimecast.com/s/laylCgJQLksByBziZVHHj" \t "_
blank" http://docs.python.org/license.html
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Software License Agreement
AJA VIDEO SYSTEMS, INC.

THIS IS AN AGREEMENT BETWEEN YOU AND AJA VIDEO SYSTEMS, INC. (“AJA”) 
THAT GOVERNS YOUR USE OF the software ACCOMPANYING THIS LICENSE (E.G., 
AS installed on the device with which this license is provided).  

The “AJA Software” referenced in this Agreement includes all such software, 
whether made available to you on disk, in read only memory, on any other 
media or in any other form, and all updates, corrections, enhancements and 
new versions of such software made available by AJA, together with all related 
documentation.  BY INSTALLING OR USING THE AJA SOFTWARE, YOU ARE 
AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT.  IF YOU DO NOT 
AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE IT AND, IF 
APPLICABLE, RETURN THE AJA SOFTWARE TO THE PLACE WHERE YOU OBTAINED 
IT FOR A REFUND.

	 1. 	 License Grant.  AJA hereby grants you a nonexclusive, personal, 
non-sublicenseable and limited license to install and use AJA Software on a 
computer or AJA device. The foregoing license also includes the right to make 
copies of the AJA Software in machine-readable form for installation and backup 
purposes only, and provided that each copy you make must include all copyright 
or other proprietary notices contained on the original.  

	 2. 	 Limitations. You may not decompile, reverse engineer, disassemble, 
modify, or create derivative works of the AJA Software or any part thereof 
except to the extent (if any) authorized by applicable law notwithstanding 
the foregoing restriction. You may not rent, lease, lend, loan, distribute or act 
as a service bureau or “cloud service” provider with respect to use of the AJA 
Software or any functionality thereof. THE AJA SOFTWARE IS NOT INTENDED 
FOR USE IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION 
OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL SYSTEMS, LIFE SUPPORT 
MACHINES OR OTHER EQUIPMENT IN WHICH THE FAILURE OF THE AJA 
SOFTWARE COULD LEAD TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR 
ENVIRONMENTAL DAMAGE.   

	 3. 	 Reservation of Rights.  The AJA Software is protected by law, 
including without limitation copyright law.  The AJA Software is licensed, not sold, 
to you.  AJA and its licensors reserve all rights not expressly granted to you by this 
Agreement.  You own the media on which the AJA Software is recorded but AJA 
and/or AJA's licensor(s) retain ownership of the AJA Software itself.  You may not 
use the AJA Software for any illegal purpose. 

	 4. 	 Transfer.  You may make a one-time permanent transfer of all of 
your license rights to the AJA Software to another person or entity, provided that: 
(a) you transfer all of the AJA Software, including all its component parts, original 
media, printed materials and this Agreement; (b) you do not retain any copies 
of the AJA Software, including any copies stored on a computer or other device; 
and (c) you transfer the AJA Software subject to this Agreement, and the person 
or entity receiving the AJA Software accepts the terms and conditions of this 
Agreement.  

	 5. 	 NFR (Not for Resale) Copies and Add-On Features: Notwithstanding 
anything to the contrary in this Agreement, (a) AJA Software that is labeled “Not 
for Resale” or otherwise provided to you on a promotional or demonstration basis 
may be used only for your demonstration, testing and evaluation purposes and 
may not be resold or transferred; and (b) AJA may make available certain software 
components (“Add-On Features”) under separate terms and conditions, in which 
case those separate terms and conditions apply and the Add-On Features are not 
considered AJA Software under this Agreement.
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	 6. 	 Termination.  Your rights in the AJA Software are conditioned on 
complying with this Agreement, and those rights (together with this Agreement) 
will terminate automatically, without notice from AJA, if you fail to comply with 
any term(s) of this Agreement. Upon termination of this Agreement, you must 
cease all use of the AJA Software and destroy all copies, full or partial, of the AJA 
Software in your possession or control.

	 7. 	 Limited Warranty on AJA Software.  If you comply with all terms of 
this Agreement and use the AJA Software in accordance with its documentation, 
and you install any patches or other updates made available to the AJA 
Software by AJA, AJA warrants that the AJA Software will perform substantially 
in accordance with its documentation for a period of ninety (90) days from 
the date of your original retail purchase.  Your exclusive remedy under this 
warranty will be, at AJA’s option, a refund of the purchase price of the product 
containing the AJA Software or an update to or replacement of the AJA Software 
(or applicable component of it).  THIS LIMITED WARRANTY AND ANY IMPLIED 
WARRANTIES ON THE AJA SOFTWARE INCLUDING, BUT NOT LIMITED TO, ANY 
WARRANTIES OF MERCHANTABILITY, OF SATISFACTORY QUALITY, OR OF FITNESS 
FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS 
FROM THE DATE OF ORIGINAL RETAIL PURCHASE.  SOME JURISDICTIONS DO 
NOT ALLOW LIMITATIONS ON HOW LONG A WARRANTY LASTS, SO THE ABOVE 
LIMITATION MAY NOT APPLY TO YOU.  THIS LIMITED WARRANTY GIVES YOU 
SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY 
BY JURISDICTION.

	 8. 	 Disclaimer of Other Warranties on Aja Software.  EXCEPT FOR THE 
LIMITED WARRANTY ON AJA SOFTWARE SET FORTH ABOVE, AJA AND AJA'S 
LICENSORS (COLLECTIVELY REFERRED TO AS "AJA" FOR THE PURPOSES OF 
SECTIONS 8 AND 9) HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS WITH 
RESPECT TO THE AJA SOFTWARE, WHETHER EXPRESS, IMPLIED OR STATUTORY, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES AND/OR 
CONDITIONS OF MERCHANTABILITY, OF SATISFACTORY QUALITY, OF FITNESS FOR 
A PARTICULAR PURPOSE, OF ACCURACY, AND OF QUIET ENJOYMENT.  FURTHER, 
AJA DOES NOT MAKE ANY WARRANTY REGARDING NON-INFRINGEMENT OF 
THIRD PARTY RIGHTS.  SUBJECT ONLY TO THE LIMITED WARRANTY SET FORTH 
IN SECTION 7, YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE 
AJA SOFTWARE IS AT YOUR SOLE RISK. AJA DOES NOT WARRANT AGAINST 
INTERFERENCE WITH YOUR ENJOYMENT OF THE AJA SOFTWARE, THAT THE AJA 
SOFTWARE WILL MEET YOUR REQUIREMENTS, THAT THE OPERATION OF THE AJA 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE 
AJA SOFTWARE WILL BE CORRECTED. NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY AJA OR AN AJA AUTHORIZED REPRESENTATIVE WILL CREATE 
A WARRANTY.  SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES OR LIMITATIONS ON APPLICABLE STATUTORY RIGHTS OF 
A CONSUMER, SO SOME OR ALL OF THE TERMS OF THIS PARAGRAPH MAY NOT 
APPLY TO YOU.

	 9. 	 Limitation of Liability. TO THE EXTENT NOT PROHIBITED BY LAW, 
IN NO EVENT WILL AJA BE LIABLE FOR PERSONAL INJURY, OR ANY INCIDENTAL, 
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR LOST PROFITS 
WHATSOEVER, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF 
DATA, BUSINESS INTERRUPTION OR ANY OTHER COMMERCIAL DAMAGES OR 
LOSSES, ARISING OUT OF OR RELATED TO YOUR USE OR INABILITY TO USE THE 
AJA SOFTWARE, HOWEVER CAUSED, REGARDLESS OF THE THEORY OF LIABILITY 
(E.G., WHETHER UNDER CONTRACT, TORT OR OTHERWISE) AND EVEN IF AJA HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. In no event will AJA's 
total liability to you for all damages (INCLUDING WITHOUT LIMITATION BREACH 
OF WARRANTY) exceed the amount of fifty dollars ($50.00).  The foregoing 
limitations will apply even if the any remedy set forth in this agreement fails of 
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its essential purpose.  SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION 
OF LIABILITY FOR PERSONAL INJURY, OR OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO SOME OR ALL OF THE TERMS OF THIS PARAGRAPH MAY NOT APPLY 
TO YOU.  

	 10. 	 Third Party Code.  Certain third party software programs may also 
be installed on or otherwise made available with the AJA device with which this 
Software License Agreement is provided.  Intellectual property rights notices and 
license terms applicable to such third party software are set forth at https://www.
aja.com/hdra-third-party-license-notice.  In addition to such third party notices 
and license terms, the disclaimer of warranties and limitation of liability provisions 
in this Software License Agreement also apply to all third party software 
programs made available by AJA (i.e., in the same manner that they apply to AJA 
Software).

	 11. 	 Export Law Assurances.  You may not use or otherwise export or 
reexport the AJA Software except as authorized by United States law and the 
laws of the jurisdiction in which the AJA Software was obtained.  In particular, but 
without limitation, the AJA Software may not be exported or re-exported (a) into 
(or to a national or resident of) any U.S. embargoed countries, or (b) to anyone on 
the U.S. Treasury Department's list of Specially Designated Nationals or the U.S. 
Department of Commerce Denied Persons List or Entity List or any similar legal 
designation.  By using the AJA Software, you represent and warrant that you are 
not located in, under control of, or a national or resident of any such country or on 
any such list.

	 12. 	 Government End Users. The AJA Software including its 
documentation is a "Commercial Item", as that term is defined at 48 C.F.R. § 2.101, 
consisting of "Commercial Computer Software" and "Commercial Computer 
Software Documentation", as such terms are used in 48 C.F.R. § 12.212 or 48 
C.F.R. § 227.7202 (or their successors), as applicable.  Consistent with these 
provisions, the AJA Software is licensed to U.S. Government end users (a) only 
as a Commercial Item and (b) with only those rights as are granted to all other 
end users pursuant to this Agreement.  Unpublished-rights reserved under the 
copyright laws of the United States.

	 13. 	 Controlling Law and Severability. This Agreement will be governed 
by and construed in accordance with the laws of the State of California, as applied 
to agreements entered into and to be performed entirely within California 
between California residents. This Agreement will not be governed by the 
United Nations Convention on Contracts for the International Sale of Goods, the 
application of which is expressly excluded. If for any reason a court of competent 
jurisdiction finds any provision, or portion thereof, to be unenforceable, the 
remainder of this Agreement will continue in full force and effect. 

	 14. 	 Complete Agreement; Governing Language.  This Agreement 
constitutes the entire agreement between the parties with respect to 
the use of the AJA Software licensed hereunder and supersedes all prior 
or contemporaneous understandings regarding such subject matter. No 
amendment to or modification of this Agreement will be binding unless in writing 
and signed by AJA. Any translation of this Agreement is intended for convenience 
and to meet local requirements and in the event of a dispute between the English 
and any non-English versions, the English version of this Agreement will govern.
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Warranty and Liability Information
AJA VIDEO SYSTEMS, INC.

Limited Warranty on Hardware
AJA Video Systems, Inc. (AJA Video) warrants that the hardware product, not 
including storage modules or software components, will be free from defects in 
materials and workmanship for a period of three (3) years from the date of purchase.  
AJA Video warrants that the storage modules provided as part of the hardware 
product will be free from defects in materials and workmanship for a period of one 
year from the date of purchase.  AJA Video provides a separate software warranty as 
part of the license agreement applicable to software components.

If a hardware product or storage module (hereafter, a “product”) proves to be 
defective during the applicable warranty period, AJA Video, at its option, will either 
repair the defective product without charge for parts and labor, or will provide a 
replacement in exchange for the defective product. 

To obtain service under this warranty, the Customer must notify AJA Video of the 
defect before expiration of the warranty period and make suitable arrangements for 
the performance of service by contacting AJA Video support through the channels 
set forth on the support contacts web page at http://www.aja.com/support.  Except 
as stated, the Customer shall bear all shipping, packing, insurance and other costs, 
excluding parts and labor, to effectuate repair. Customer shall pack and ship the 
defective product to a service center designated by AJA Video, with shipping charges 
prepaid.  AJA Video shall pay to return the product to Customer but only if to a 
location within the country in which the AJA Video service center is located.

This warranty shall not apply to any defect, failure or damage caused by negligent, 
inadequate or improper use, handling or maintenance.  Without limiting the 
foregoing, AJA Video shall not be obligated to furnish service under this warranty 
or repair any damage or malfunction a) resulting from attempts by personnel other 
than AJA Video representatives to install, repair or service the product, b) resulting 
from improper use or connection to incompatible equipment, c) caused by the use 
of non-AJA Video parts or supplies, d) if the product has been modified or integrated 
with other products when the effect of such a modification or integration increases 
the time or difficulty of servicing the product, or e) resulting from being dropped 
or otherwise subjected to undue force, exposure to moisture or other corrosive or 
conductive substances, exposure to strong magnetic fields, use with improperly 
regulated power supplies, exposure to electric shock, use in temperatures outside the 
specified operating range, or otherwise failing to treat the product in accordance with 
the standard of care appropriate to sensitive and delicate electronic equipment.

EXCEPT AS STATED ABOVE, AJA VIDEO AND ITS VENDORS DISCLAIM IN THEIR 
ENTIRETY ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT 
LIMITATION ALL WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE.  AJA VIDEO’S RESPONSIBILITY TO REPAIR OR REPLACE TIMELY REPORTED 
DEFECTIVE PRODUCTS IS THE WHOLE AND EXCLUSIVE REMEDY CUSTOMER IS 
PROVIDED WITH RESPECT TO HARDWARE PRODUCTS AND THEIR STORAGE MODULES.  
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR 
LIMITATIONS ON APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO SOME OR ALL 
OF THE TERMS OF THIS PARAGRAPH MAY NOT APPLY TO YOU.

THE PRODUCT IS NOT INTENDED, STATED, OR WARRANTED TO OPERATE 
UNINTERRUPTED OR ERROR-FREE.  YOU UNDERSTAND AND ACKNOWLEDGE THAT THE 
PRODUCT IS NOT INTENDED TO BE USED AS THE SOLE OR PRIMARY DATA SOURCE OR 
TARGET FOR CRITICAL DATA, AND THAT IT IS YOUR RESPONSIBILITY TO IMPLEMENT 
REDUNDANT CAPTURE AND BACKUP SYSTEMS AS APPROPRIATE.
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Limitation of Liability
Under no circumstances shall AJA video BE LIABLE IN ANY WAY FOR ANY LOST, 
CORRUPTED OR DESTROYED DATA, FOOTAGE OR WORK, OR FOR ANY OTHER 
INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OR LOST PROFITS, 
OR FOR ANY THIRD PARTY CLAIM, IN CONNECTION WITH THE PRODUCT, WHETHER 
RESULTING FROM DEFECTS IN THE PRODUCT, SOFTWARE OR HARDWARE FAILURE, 
OR ANY OTHER CAUSE WHATSOEVER, EVEN IF AJA VIDEO HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. AJA VIDEO’S LIABILITY IN CONNECTION WITH THE 
PRODUCT SHALL UNDER NO CIRCUMSTANCES EXCEED THE PURCHASE PRICE PAID 
FOR THE PRODUCT.  The foregoing limitations apply even if any remedy set forth in 
this LIMITED WARRANTY fails of its essential purpose.  SOME JURISDICTIONS DO NOT 
ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL INJURY, OR OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO SOME OR ALL OF THE TERMS OF THIS PARAGRAPH 
MAY NOT APPLY TO YOU.  

Governing Law and Language; Your Rights. 
This limited warranty is the only warranty provided by AJA Video on the hardware 
product.  It supersedes all prior or contemporaneous understandings regarding such 
subject matter.  No amendment to or modification of this warranty will be binding 
unless in writing and signed by AJA Video.  The laws of the State of California, USA 
will govern this warranty and any dispute arising from it.  Any translation of this 
Agreement is intended for convenience and to meet local requirements and in the 
event of a dispute between the English and any non-English versions, the English 
version of this warranty will govern.  This limited warranty gives you specific legal 
rights and you may have other rights that vary from jurisdiction to jurisdiction, some 
of which are noted above. 
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